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Adjusting and Separating Map Colors 
Using PhotoShopTM 

As more and more maps are being prepared for display on CRTs, our 
need for a method to convert them into printable or slide form is 
increasing. A screen capture of the image can be manipulated in 
PhotoShop to select appropriate colors. A finishing program such as 
Free Hand can be used for adding high-quality lettering, placing 
appropriately on the page, and creating color separations or a slide file. 
Different applications require creativity in solving specific problems, 
but the method is versatile and easy to apply. 

Y ou ha\·e a map displayed on a CRT. You need a high-quality copy of 
the map for com·entional process-color printing or for making a 

slide, but a) the program that produces the display does not produce 
color separations, or b) the color capabilities of the sofn..•are prevent you 
from using the colors you need, or c) you are displaying a (copyright­
free) GIF image from the World Wide Web and you need to crop and 
annotate. With the increased use of GIS software and the Web, you may 
be increasingly finding yourself with images that need transformation. 
How do you convert the diverse images we can produce on CRTs into 
high-quality printable form or into slides? And how do you transform 
the colors into selections of i,vh.ich you can be proud instead of apolo­
getic? The logical choice of software seems to be PhotoShop, but what 
does one do with it to get the well-colored image in the appropriate 
format? 

I recently had just such a problem. CRT maps had been used in a 
testing project (Olson and Brewer, 1997) and had been produced on a 
computer system no longer available. Fortunately, the programs had 
been written in QuickBASIC, a copy of which was still available, and no 
map had more than about ten colors on it. Not so fortunately, we had 
been using a smart terminal that had its own subroutines to produce 
eight-bit color and we had carefully selected and tweaked the colors to 
adhere to certain schemes and constraints. The nine standard colors 
a\·ailable in QuickBASIC did not even resemble the logical series we had 
used in the testing project. The problem was to produce a set of color 
separations for publication that would simulate reasonably well the 
colors used in the testing project. 

Here is a method that works to convert CRT-displayed maps into 
printable or slide form. Readers are spared the many blind alleys taken 
along the way in developing this sequence. 

1) Use a printed color chart to choose the CMYK (cyan, 
magenta, yellow, black) percentage combinations that 
vvill be needed to produce the desired colors. CRT 
colors cannot be reproduced exactly, and colors that 
look right on the CRT do not necessarily look right 

Judy M. Olson 
Depn rt men t of Geog rnplly 
Mic/1ign11 Stnte University 
Enst Lansing, Michigan 48823 

THE PROBLEM 

A SOLUTION 



20 cartograplzic perspectives Number 25, Fall 19% 

11 There is no substitute for 
using a good printed color 

chart." 

"Display the map on a CRT and 
screen capture it using a 

shareware program such as 
Graphix or, if it is displayed in 
a Windows environment, press 

Print Screen." 

when printed. There is no substitute for using a good 
printed color chart. 

2) You will not normally need this step, but in my case I 
had to revise the QuickBASIC programs to omit calls to 
subroutines that were specific to the original output 
terminal. I assigned an arbitrary color to each different 
color on each map. In cases where the number of colors 
exceeded 8, I reused colors, making sure that the lines 
separating units were unique (i.e., I did not reuse the line 
color for anything else). All lettering (which was fortu­
nately sparse) was omitted by commenting out the 
relevant lines in the QuickBASIC program. 

3) Display the map on a CRT and screen capture it using a 
shareware program such as Graphix or, if it is displayed 
in a Windows environment, press Print Screen. I used 
Graphix to capture each map as either a GIF or PCX file; 
either format worked well. (I could not use the "Screen 
Display" option in Quick BASIC to display the map for 
capture but had to display using the Run command. This 
meant I captured any messages on the screen as well as 
the map, but I scaled the image so the messages fell 
outside the map area.) 

4) Open the GIF or PCX capture file in PhotoShop (I used 
PhotoShop 3.0 residing on a Power Macintosh 8100/100 
with 96 Mb of RAM and 650 Mb hard disk). Use the 
eraser to clean up any unwanted messages or extraneous 
marginal marks if any. 

5) Use the Rectangular Marquee from the Toolbox to 
window the exact area of the graphic that you wish to 
retain. (My background color was black and I wanted 
the rectangular area of each of 15 maps to be exactly the 
same size on the final product, which meant this step was 
crucial.) Double-click on the Rectangular Marquee to 
bring up the dialogue box in which you can set the style 
to Constrained Aspect Ratio and specify a width and 
height. (In my case, I used 2.6 by 1.75, as the final image 
was be that size in inches. It is only the ratio that is 
important here, however. For slides, use 3 by 2 as the 
aspect ratio.) Use the tool with the Option key pressed 
for extending from the center of selection. Noting your 
choice of center on a given try, adjust and retry. If more 
background area is needed to get the proper window, 
increase the Canvas Size (Image menu). When the 
Marquee window is satisfactory, pull down the Edit 
menu and select Crop. 

6) If you need to add new colors (such as I did when the 
number exceeded 8), click (once) on the Foreground 
Color square to open the Color Picker dialogue box. 
Specify a new (arbitrary at this point) color. Selecting a 
color that is simply very different from the rest can make 
this step easier. After closing the Color Picker, double-
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click on the Paint Bucket and be sure the Anti-alias 
feature is deselected (to prevent a blurry map). Click the 
Paint Bucket in each area to be filled with the new color. 

7) Save the file so you do not ha\·e to deal with the un­
wanted lettering, the cropping, or the duplicated colors 
again. 

8) By default, the file opened in "Indexed Color" Mode. It 
is not possible to accomplish the remaining modifications 
using that mode. Bring down the Mode menu and select 
CMYK. Save the file in PhotoShop format with a modi­
fied file name so as to preserve the GIF or PCX file as a 
backup. 

9) In CMYK Mode, change the colors as follows: 

a) Double-click the Magic Wand to bring up its 
dialogue box. Make sure the Anti-alias box is 
deselected and the tolerance is zero. 

b) Select a legend box or map unit that is the color 
you wish to change. 

c) In the Select menu, select Similar to pick up all 
other areas of the same color. 

d) Use the Eyedropper tool to sample the selected 
color. The color then appears as the current 
Foreground Color in the Toolbox. 

e) Single click on the Foreground Color in the lower 
part of the Toolbox to open the Color-Picker 
dialogue box. Type in the CvfYK values desired 
and press Return (or click OK). 

f) At this stage, the new color is in the Foreground 
color box only. Press Option and Delete to 
change the colors in all the selected areas to the 
ne\v color. 

g) Repeat steps /J through/for each of the other 
colors needing adjustment. 

h) Save the file again (still in PhotoShop format) so 
you have all the changes included. This will 
serve as a backup file. 

i) Use Save As in the File menu and choose the 
TIFF format and a modified filename. Upon 
clicking Save, the TIFF dialogue box opens; select 
LZW compression. Uncompressed files are 
extremely large (mine were 14-20 times the 
compressed size), and the compressed versions 
work \veil. 

10) Use FreeHand (I used version 5.0, on the same Mac) or 
similar graphics package as the finishing software. In 
FreeHand, select Place from the File menu and select the 
TIFF image you saved. Click in some convenient (arbi­
trary) point on the page for placement. Choosing the 
Object Inspector (first icon in the Inspector window) you 
can specify the x,y location of the lower left corner and 
the size desired (2.6 x 1.75 inches in my case), and press 

11 Use the Eyedropper tool to 
sample the selected color. The 
color then appears as the cur­
rent Foreground Color in the 
Toolbox." 

"Press Option and Delete to 
change the colors in all the 
selected areas to the new color. 11 

11 Uncompressed files are ex­
tremely large (mine were 14-20 
times the compressed size), and 
the compressed versions work 
well. " 
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"Replacing the originals pre­
vents old versions from becom­
ing confused with new ones, it 

saves disk space, and (very 
important) the FreeHand file 

you created will automatically 
use the new version.'' 

PITFALLS 

Return. Alternatively, you can use the scaling tool and 
then drag the image to the desired location. 

11) Add lettering in a higher layer using the convenient type 
features in FreeHand or similar software. 

12) Be sure to save the file at this stage (FreeHand format), so 
you have a complete copy of your work. 

13) The next step depends on whether your map will be 
printed or made into a slide. 

a) If the map is to be printed, produce a color proof 
and examine the colors carefully. 

b) If the map is to be made into a slide and the film 
recorder is not directly accessible, be sure you 
have the appropriate printer driver on your 
machine for whatever film recorder is available. 
Use it to save the FreeHand file in the new 
format. In our case, we use the printer driver 
that produces Binary LasergraphicsTM Language 
(extension .BLL). The file can then be taken to 
the film recorder. 

14) Make revisions if needed. Use the PhotoShop format 
files to do so. Save not only the revised PhotoShop file 
but also the TIFF file with the same names you used 
before. Replacing the originals prevents old versions 
from becoming confused with new ones, it saves disk 
space, and (very important) the FreeHand file you 
created will automatically use the new version. 

In PhotoShop one has to be cautious about duplicate colors. If, for ex­
ample, the second box in the legend is 100% cyan and one wishes the color 
in the first box to be 100% cyan, the second legend color must be changed 
first. Otherwise, both the first and second colors become equal and all of 
them are selected upon trying to isolate only one of them. 

Due to the conversion from vector to bitmap format when a screen 
capture is made, lines are not consistent in width. Most of ours were one 
pixel but some were two. I used the pen tool in PhotoShop to correct 

c M y K B&W 
background: 0 0 0 100 0 
No harvest: 0 10 30 0 10 
0.1-49: 0 40 60 0 20 
50-99: 0 65 85 10 35 
100-399: 0 80 95 40 50 
400-999: 0 100 100 50 70 

Table 1. 
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some of them, but the \'ariation was not particularly bothersome in the 
case of these maps because the final size of each map was small. 

The illustrations I was producing had several maps (7 or 8) on each 
final page. The FreeHand file plus all the associated TIFF files for each 
page fit onto one 1..14 \1b diskette. Had we not used the LZW compres­
sion, file size of some individual TIFFs, much less the whole set, would 
ha\·e been too large for a single diskette. 

Although readers are generally spared the blind alleys here, there is 
one that is so tempting that I must warn you against it. When you are in 
Index Color mode in PhotoShop, you can open up the Color Table and 
change se\·eral colors at once before closing it. It lures one into thinking 
this is an easier means of color adjustment, but it is fraught with problems. 
The vvorst is that the color designations change automatically (without 
warning to you; you ha\·e to reopen the color table and read the numbers 
to see that it did not accept what you typed in). Although the automati­
cally-modified color may look fine on the screen, the resulting color proofs 
can be a huge disappointment. The use of the Color Table process in 
Index Color mode turns out to be wasted time. 

To try the steps outlined above to modify a map in PhotoShop, we offer 
a sample file that can be downloaded from the internet: pilot.msu.edu/ 
user/ olsonj/ nwestmap.gif. The colors in the original file are arbitrary. 
There is no need for adding colors (Step 6 above), but you may want to try 
that with just one map unit and then undo the Paint Bucket fill. FreeHand 
or similar softv<are can be used to finish the map with lettering. Table 1 
shO\o\'S some potential specifications for the map. The CMYK values 

Timber Harvest 
Pacific Northwest 

1981 
Harvest by County 
(Million Board Feet) 

400-999 
100·399 
50-99 
0.1-49 
No Harvest 

Fis1ire 1. A l'ri11tcd 111111• 1•r•'!'t1rcd 11-mg t!tc 1111•thod,; 1>11tlil1ed. 

would be used for a color \·ersion; the B&W \·alues produced the black­
and-white version shown in Figure 1. 

As it becomes more and more important to transform maps from one 
format to another, we need to know the combinations of commands that 
allow us to reach our goals. It was a significant investment of time and 
effort in manual reading, trial and error, and asking questions of others 
who use PhotoShop before I succeeded in understanding how simple a 

''Although readers are generally 
spared the blind alleys here, 
there is one that is so tempting 
that I must warn you against 
if. II 
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